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O-01 (ANSYS) 
Формулировка задачи: 

Дано: E, a, q, l, ν=0,25 

Односвязная 

плоскопространственная рама 

постоянного поперечного 

сечения, наруженная 

распределённой силой. 

Найти: 1) Эпюру внутренних моментов; 

2) Вертикальное перемещение точки B: δB. 

Аналитический расчёт (см. O-01) даёт следующие решения: 

4

z 2,2I 5 a= Ö - изгибный момент инерции поперечного сечения; 

4

y zI a I0,25 0,1111= Ö = Ö - второй осевой момент инерции; 

4

ê zI 0,789 0,3 7a I50= Ö = Ö- геометрическая жёсткость 

поперечного сечения при кручении; 
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Рис. 1. 

Задача данного примера: при помощи ANSYS Multyphisics получить эти же 

результаты методом конечных элементов. 
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Предварительные настройки: 

Для решения задачи используется ANSYS Multiphysics 14.0: 

 

 

 

Utility Menu (U_M) 

Main Menu 

(M_M) 

Рабочее поле 

ANSYS Command Prompt (C_P) 

Кнопка 

Fit 

 

C меню M_M и U_M работают мышью, выбирая нужные опции. 

В окно C_P вручную вводят текстовые команды, после чего следует 

нажать на клавиатуре . 

 

Чёрное рабочее поле не всегда 

приятно для глаза. Кроме того, оно 

неудобно для печати рисунков. 

Меняем чёрный цвет фона на белый 

следующими действиями: 

U_M > PlotCtrls  > Style  > Colors  

> Reverse  Video  

 

Убрать пункты меню, относящиеся к 

расплавам, магнитам и так далее, оставить только 

относящиеся к прочностным расчётам: 

M_M > Preferences > ʆʪʤʝʪʠʪʴ ñStructural ò > OK 
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При построениях полезно видеть номера 

точек и линий твердотельной модели: 

U_M > PlotCtrls  > Numbering  > 

ʆʪʤʝʪʠʪʴ KP, LINE  ;  

ʋʩʪʘʥʦʚʠʪʴ Elem ʥʘ ñNo numbering ò; 

ʋʩʪʘʥʦʚʠʪʴ [/ NUM] ʥʘ ñColors  & numbers ò 

> OK 

Для большей наглядности увеличим размер шрифта: 

U_M > PlotCtrls  > Font Controls  > Legend Font  > 

ʋʩʪʘʥʦʚʠʪʴ çʈʘʟʤʝʨè ʥʘ ç22è 

> OK 

U_M > PlotCtrls  > Font  Controls  > Entity  Font  > 

ʋʩʪʘʥʦʚʠʪʴ çʈʘʟʤʝʨè ʥʘ ç22è 

> OK 

 

 

 

 

 

Предварительные настройки выполнены, можно приступать к решению 

задачи. 
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Решение задачи: 

ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

1 

Задаём параметры расчёта – базовые величины задачи: 

U_M > Parameters > Scalar Parameters  > 

E=1           > Accept >  

q=1           > A ccept >  

l =1           > Accept >  

a=l/20          > Accept  > 

Iz =1          > Accept  > 

Iy =0. 1111 * Iz   > Accept  > 

Ik =0.3507 * Iz   > Accept  > 

ASect =1e6     > Accept  > 

nu=0. 25       > Accept >  

> Close   

2 

Первая строчка в таблице конечных элементов – балочный тип BEAM44: 

M_M  > Preprocessor  

C_P  > ET,1, BEAM44 >  

ʇʦʩʤʦʪʨʠʤ ʪʘʙʣʠʮʫ ʢʦʥʝʯʥʳʭ ʵʣʝʤʝʥʪʦʚ:  

M_M > Preprocessor > Element Type > Add/Edit/Delete > Close   

3 

Реальные константы для элемента BEAM44: 

C_P > R, 1, ASect,Iz,Iy,a,3*a,Ik  >  

ʇʦʩʤʦʪʨʠʤ ʪʘʙʣʠʮʫ ʨʝʘʣʴʥʳʭ ʢʦʥʩʪʘʥʪ:  

M_M > Preprocessor > Real Constants > Add/Edit/Delete > Close  
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

4 

Свойства материала стержня – модуль упругости и коэффициент Пуассона: 

M_M > Preprocessor  > Material  Props  > Material  Models  > 

Structural > Linear > Elastic > Isotropic >  

ɺ ʦʢʦʰʢʝ EX ʧʠʰʝʤ ñEò, ʚ ʦʢʦʰʢʝ PRXY ʧʠʰʝʤ ñnuò 

> OK 

ɿʘʢʨʳʚʘʝʤ ʦʢʥʦ çDeine Material Model Behaviorè. 
 

Твердотельное моделирование 

5 

Координаты узлов рамы: 

Определяемся с положением рамы относительно глобальной декартовой системы 

координат. 
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Ключевые точки  A→1, B→2, C→3: 

M_M> Preprocessor> M ʦdeling> Create> Keypoints> In Active CS>  

NPT ʧʠʰʝʤ 1 

X, Y,Z  ʧʠʰʝʤ   0, 0,  l       > Apply  > 

NPT ʧʠʰʝʤ 2 

X, Y,Z  ʧʠʰʝʤ 2*l, 0, l      > Apply  > 

NPT ʧʠʰʝʤ 3 

X, Y,Z  ʧʠʰʝʤ 2*l, 0, 0  > OK 

Прорисовываем всё, что есть:  U_M > Pl ot  > Multi - Plots  

 - изометрия;   - автоформат. 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

7 

Оcи стержней рамы: 

M_M > Preprocessor > M ʦdeling > Create > Line s > Lines  > 

Straight Line > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʧʦʩʣʝʜʦʚʘʪʝʣʴʥʦ ʥʘʞʘʪʴ ʥʘ ʢʣʶʯʝʚʳʝ ʪʦʯʢʠ: 

1 ʠ 2 

2 ʠ 3  

> OK 

Прорисовываем всё, что есть: 

U_M > Pl ot  > Multi - Plots  

 

8 

Закрепления: 

M_M > Preprocessor  > Loads  > Define  Loads  > Apply  > 

Structural  > Displacement  > On Keypoints  > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʥʘʞʘʪʴ ʥʘ 1 ʢʣʶʯʝʚʫʶ ʪʦʯʢʫ 

> OK > 

Lab2 ʫʩʪʘʥʦʚʠʪʴ ñUYò  

> Apply  

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʥʘʞʘʪʴ ʥʘ 3 ʢʣʶʯʝʚʫʶ ʪʦʯʢʫ 

> OK > 

Lab2 ʫʩʪʘʥʦʚʠʪʴ ñAll DOF ò  

> OK 

Прорисовываем всё, что есть: 

U_M > Pl ot  > Multi - Plots   
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

Конечноэлементная модель 

9 

Указываем материал, тип элементов и номер поперечного сечения: 

M_M > Preprocessor  > Meshing  > Mesh Attributes  > All  Lines  > 

[ TYPE]    ʫʩʪʘʥʦʚʠʪʴ ñ1 BEAM44ò 

[ MAT]     ʫʩʪʘʥʦʚʠʪʴ ñ1ò 

[ REAL]    ʫʩʪʘʥʦʚʠʪʴ ñ1ò 

> OK 
 

10 

Размер элементов: 

Линия L1 нагружена распределённой поперечной силой, её нужно разбить 

несколькими конечными элементами; линия L2 без распределённых нагрузок можно 

бить одним конечным элементом: 

M_M > Preprocessor  > Meshing  > Size  Cntrls  > ManualSize > 

Lines  > Picked  Lines >  

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʢʣʠʢʘʝʤ ʥʘ ʣʠʥʠʶ L1 

> OK 

NDIV ʧʠʰʝʤ 20 

> Apply  > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʢʣʠʢʘʝʤ ʥʘ ʣʠʥʠʶ L2 

> OK > 

NDIV ʧʠʰʝʤ 1 

> OK 

Обновляем изображение: 

U_M > Plot  > Multi - Plots  
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11 

Рабиваем линии на элементы: 

M_M > Preprocessor  > Meshing  > Mesh > Lines  > Pick  All  

Обновляем изображение: 

U_M > Plot  > Multi - Plots   

ɺʠʜʠʤ ʩʨʘʟʫ ʜʚʝ ʤʦʜʝʣʠ ï ʪʚʝʨʜʦʪʝʣʴʥʫʶ ʠ ʢʦʥʝʯʥʦʵʣʝʤʝʥʪʥʫʶ.  

 

12 

Указываем, что именно нужно теперь прорисовывать по команде Multi-Plots: 

U_M > PlotCtrls  > Multi - Plot Controls  >  

ʇʦʷʚʣʷʝʪʩʷ ʧʝʨʚʦʝ ʦʢʥʦ Multi - Plotting  > OK > 

ʇʦʷʚʣʷʝʪʩʷ ʚʪʦʨʦʝ ʦʢʥʦ Multi - Plotting  > 

ʆʩʪʘʚʣʷʝʤ ʚ ʥʸʤ ʦʪʤʝʪʢʠ ʪʦʣʴʢʦ ʥʘʧʨʦʪʠʚ Nodes ʠ Elements  

> OK 

Обновляем изображение:  U_M > Plot  > Multi - Plots   

ʊʝʧʝʨʴ ʚʠʜʠʤ ʪʦʣʴʢʦ ʢʦʥʝʯʥʦʵʣʝʤʝʥʪʥʫʶ ʤʦʜʝʣʴ. 
 

13 

Переносим на конечноэлементную модель нагрузки и закрепления с модели 

твердотельной: 

M_M > Loads  > Define  Loads  > Operate  > Transfer  t o FE > All  

Solid  Lds  > OK 

Обновляем изображение: 

U_M > Plot  > Multi - Plots  
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

14 

Проверяем ориентацию поперечного сечения: 

U_M > PlotCtrls  > Style  > Size  and  Shape > 

[/ ESHAPE] ʫʩʪʘʥʦʚʠʪʴ ʦʪʤʝʪʢʫ ñonò > OK 

Корректируйте масштаб кнопками ,  или . 

Видно, что плоскость рамы параллельна меньшей стороне сечения, как и должно 

быть. Убираем прорисовку сечения: 

U_M > PlotCtrls  > Style  > Size  and  Shape > 

[/ ESHAPE] ʫʙʨʘʪʴ ʦʪʤʝʪʢʫ, ʫʩʪʘʥʦʚʠʚ ñof f ò > OK  

15 

Поперечная распределённая нагрузка ·q: 

M_M > Preprocessor  > Loads  > Define  Loads  > Apply  > 

Structural  > Pressure  > On Beams > 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʦʪʤʝʯʘʝʤ 20 ʵʣʝʤʝʥʪʦʚ ʜʣʠʥʥʦʛʦ ʩʪʝʨʞʥʷ 

> Apply  > 

LKEY ʧʠʰʝʤ 2 

VALI  ʧʠʰʝʤ q 

> OK 

Обновляем изображение: U_M > Plot  > Multi - Plots   

Расчёт 

16 

Запускаем расчёт: 

M_M > Solution  > Solve  > Current LS  

Синхронно появляются два окна: белое информационное и серое исполнительное. 

Белое закрываем, на сером нажимаем OK. Расчёт пошёл. 

Когда он закончится, появится окно «Solution is done!». Закройте это окно. 

Расчёт окончен. 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

Просмотр результатов: 

17 

Силовая схема: 

U_M > PlotCtrls  > Symbols  > 

[/ PBC] ʫʩʪʘʥʘʚʣʠʚʘʝʤ ʚ ʧʦʣʦʞʝʥʠʝ ñFor  Individual ò 

ʋʙʠʨʘʝʤ ʛʘʣʦʯʢʫ ʩ ñMiscellaneousò 

Surface Load Sym bols ʫʩʪʘʥʘʚʣʠʚʘʝʤ Pressures  

Show pres and convect as   ʫʩʪʘʥʘʚʣʠʚʘʝʤ  Arrows  

> OK > 

В окне “Applied Boundary Conditions” 

  U ʫʩʪʘʥʦʚʠʪʴ ñOff ò 

Rot  ʫʩʪʘʥʦʚʠʪʴ ñOff ò 

  F ʫʩʪʘʥʦʚʠʪʴ ñSymbol +Value ò 

  M ʫʩʪʘʥʦʚʠʪʴ ñSymbol +Value ò 

> OK >  

В окне “Reactions”  

NFOR ʫʩʪʘʥʦʚʠʪʴ ñOff ò 

NMOM ʫʩʪʘʥʦʚʠʪʴ ñOff ò 

RFOR ʫʩʪʘʥʦʚʠʪʴ ñSymbol+Valueò 

RMOM ʫʩʪʘʥʦʚʠʪʴ ñSymbol+Valueò 

> OK 

Обновляем изображение: U_M > Plot  > Elements  

Получаем тот же результат, что и на рис. 1. 

В рабочем поле видим следующее: 

- Красным цветом начерчена распределённая внешняя сила; 

- Малиновым цветом нарисованы реактивные силы; 

- Фиолетовым начерчены векторы реактивных моментов: изгибного (поперёк оси 

короткого стержня) и крутильного (вдоль его оси). 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

18 

Вид сверху: 

 - вид сверху; 

  - автоформат (размер изображения по размеру окна рабочего поля). 

 

19 

Цветовая шкала будет состоять из десяти цветов: 

U_M > PlotCtrls  > Style  > Contours  > Uniform Contours >  

NCONT ʧʠʰʝʤ 10 

> OK 

 

20 

Составление эпюры внутреннего изгибающего момента Mизг: 

M_M > General  Postproc  > Element  Table  > Define  Table  > Add > 

ñBy sequence  numò, ñSMISC,ò,  ñ6ò 

> Apply  >  

ñBy sequence  numò, ñSMISC,ò,  ñ12ò 

> OK > 

> Close  

Смотрим таблицу результатов: 

M_M > General Postproc  > Element Table  > Define Table > Close 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

21 

Прорисовка эпюры Mизг: 

M_M > General Postproc  > Plot Results  > Contour Plot  > 

Line Elem Res > 

LabI  ʫʩʪʘʥʦʚʠʪʴ ñSMIS6ò 

LabJ  ʫʩʪʘʥʦʚʠʪʴ ñSMIS12ò 

Fact  ʧʠʰʝʤ 1 

> OK 

Получаем тот же результат, что и на рис. 1. (только числа, выделенные синим 

цветом). Значения показывает цветовая шкала. А, вот, со знаками (“вверх” эпюра 

или “вниз”) осторожно! Быть уверенным здесь можно только в форме. 

Можете рисунок эпюры сделать крупнее: коэффициент Fact установите 2 или 3. 
 

22 

Составление эпюры внутреннего крутящего момента Mкр: 

M_M > General  Postproc  > Element  Table  > Define  Table  > Add > 

ñBy sequence  numò, ñSMISC,ò,  ñ4ò 

> Apply  >  

ñBy sequence  numò, ñSMISC,ò,  ñ10ò 

> OK > 

> Close  

Смотрим таблицу результатов: 

M_M > General Postproc  > Element Table  > Define Table > Close 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

23 

Прорисовка эпюры Mкр: 

M_M > General Postproc  > Plot Results  > Contour Plot  > 

Line Elem Res > 

LabI  ʫʩʪʘʥʦʚʠʪʴ ñSMIS4ò 

LabJ  ʫʩʪʘʥʦʚʠʪʴ ñSMIS10ò 

Fact  ʧʠʰʝʤ 1 

> OK 

Получаем тот же результат, что и на рис. 1. (только числа, выделенные синим 

цветом). Значения показывает цветовая шкала. В эпюрах крутящего момента, в 

отличие от изгибающего, можете быть уверенными и в знаках моментом тоже. С 

аналитическими расчётами знаки совпадают всегда. 

В данном случае видим: крутящий момент на длинном стержне нулевой, на 

коротком - положительный.  

24 

Выделяем узел в точке B: 

Узлы и элементы: 

U_M > Plot  > Multi - Plots  

Выделяем узел в точке B (угловой узел): 

U_M > Select  > Entities  > 

ʋʩʪʘʥʘʚʣʠʚʘʝʤ ñNodesò ʠ ñBy Num/ Pick ò 

ʉʝʣʝʢʪʦʨ ʫʩʪʘʥʦʚʠʪʴ ʥʘ ñFrom Full ò 

> OK 

ʃʝʚʦʡ ʢʥʦʧʢʦʡ ʤʳʰʠ ʢʣʠʢʥʫʪʴ ʥʘ ʫʛʣʦʚʦʡ ʫʟʝʣ. ʅʘ ʧʘʥʝʣʴʢʝ 

ʧʦʷʚʣʷʝʪʩʷ ʥʦʤʝʨ ʫʟʣʘ. ɺʠʜʥʦ, ʯʪʦ ʵʪʦ ʫʟʝʣ ˉ2. 

> OK 
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ˉ ɼʝʡʩʪʚʠʝ ʈʝʟʫʣʴʪʘʪ 

25 

Вертикальное перемещение узла №2 ( точка B) 

M_M > General Postproc  > List Results  > 

> Nodal Solution  > Nodal Solution  > 

> DOF Solution > Y- Component of displacement >  

> OK 

Получаем методом конечных элементов: 

4

z
B2

0,3369 âí èç ( î ò ðèö
q l

E I
àò åëüí û é ) ;d d= =
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Ö
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что в точности совпадает с результатом аналитического расчёта (рис. 1.). 
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Сохраняем проделанную работу: 

U_M > File  > Save as Jobname.db  

Закройте ANSYS: 

U_M > File  > Exit > Quit ï No Save! > OK  

 

После выполнения указанных действий в рабочем каталоге остаются 

файлы с расширениями “.BCS”, “.db”, “.emat”, “.err”, “.esav”, “.full”, “.log”, 

“.mntr”,  “.rst”, ”.stat” и “SECT”. 

Интерес представляют “.db” (файлы модели), “.rst” (файл результатов 

расчёта) и файл “.SECT” (поперечное сечение), остальные файлы 

промежуточные, их можно удалить. 

 


